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Customer Release Notes

Splash G640 Color Server, version 4.0
for the Xerox DocuColor 12 series

This document contains information about Splash G640 Color Server server software,
version 4.0. Before using the Splash G640 Color Server with version 4.0, make a copy of
these Customer Release Notes and distribute them to all users.

Note: The term “Splash G640” is used in this document to refer to the Splash G640
Color Server. The term “Windows 9x” is used in this document to represent Windows 95
and Windows 98.

Before printing to the Splash G640:

* Make sure system software version 4.0 is installed on the Splash G640.

* Install user software onto client computers. For instructions, see the User Guide.

-199 Error

In unusual circumstances, the Splash G640 may display a message stating that a -199 error
has occurred. This error occurs when a corrupt spool file is found in the spool folder. To
workaround this problem, remove all of the spool files from the Spool folder, start the
Splash G640, and then drop the spool files into the Drop Folder. Drop the files individually
to isolate the corrupt file, and then delete it from the Spool folder. To perform this
procedure, we recommend that you stop the Splash G640 after it automatically starts.

Thumbnails

Thumbnails may still be present after the job has printed and left the Active queue. The
thumbnail disappears upon any mouse action or a new job entering the queue.

Printer status during Energy Saver Mode

When the printer is in Energy Saver mode, the Splash G640 reports the printer status as
Online. When a job is printed to the Splash G640, the server brings the printer out of
Energy Saver mode and prints the job. If the printer is turned off while the printer is in
Energy Saver mode, the Splash G640 continues to report the printer status as Online until
the printer is turned on.

Error message after Energy Saver Mode

When a job starts printing while the printer is in Energy Saver Mode, the Splash G640 may
display the error message stating “Printer is Not Responding” for a few seconds. Once the
printer is fully out of Energy Saver Mode, the error message disappears.

Changing tray contents while printer in Energy Saver Mode

The Splash G640 does not detect changes in tray contents while the printer is in Energy
Saver Mode. This may cause jobs to error if they request the page size that was changed. If
this occurs, bring the printer out of Energy Saver Mode before resubmitting the job.
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Disk space and saving image files

If jobs are printed with the Save Images option selected, the Splash G640 may run low on
disk space, which may affect the processing of subsequent jobs. We recommend that you
delete image and spool files regularly.

Out of disk space while printing

If the Splash G640 runs out of disk space while printing jobs, it may stop printing. To
correct this problem, move the jobs from the Active queue into the Hold queue, delete
image files or other files from the hard drive, and then resubmit the jobs to the

Active queue.

Folder icons

If you uninstall the Splash G640 software and some components cannot be removed, the
folder icons for the Splash folder and Splash utilities folder revert to standard folder icons
and the Splash folder icon may disappear entirely.

Windows test page errors with Secure Access enabled

If Secure Access is enabled at the Splash G640, the test page printed from a Windows
computer when the Splash print driver is installed errors at the server with a message stating
that some required Secure Access field is incorrect. To correct the problem, edit the job at

the Splash G640.

Installer replaces ‘httpdconfig’ file
The Splash G640 installer replaces the httpdconfig file. This file sets up certain properties

for Web access to the server Mac OS. If you are installing onto a Mac which has previously
had Web access set up, you will need to reconfigure the previous Web access after installing

the Splash G640.

Monitor resolution

In full screen mode, the Splash G640 requires the monitor resolution to be at least

1024x768. If the server is in full screen mode and the monitor resolution is changed to less
than 1024x768, the full screen user interface appears clipped. To work around this, set the
monitor resolution to at least 1024x768 or put the Splash G640 into partial screen mode.

For partial screen mode to display without clipping, the monitor resolution must be set to
at least 800x600. If the resolution is set below 800x600, the partial screen user interface
appears clipped.

Server IP Address Changes

If the Splash G640 IP address is changed either by a DHCP server or by manually editing
the IP address in the Network system preference, the server cannot receive jobs over the
network and remote users cannot connect via the web interface. Quit the Splash G640 and
start it again.

“Last Calibrated” Message

The “Last Calibrated” message on the Splash G640 UI does not automatically update after
calibration. To update the message, put the server in the background or quit and restart the

SErver.
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Printing via Novell from Windows 2000

In order to print from a Windows 2000 computer to either a Novell NDS queue, you must
install and configure Client Services for Netware from the Windows 2000 CD.

Note: Novell Client from Novell is not currently supported on Windows 2000.

Canceling jobs in a Novell Print Server queue

If a Novell NDS Print Server is attached to a Splash G640, canceling a job in the Novell
Print Server Queue can cause the Splash G640 to crash. To avoid printing a job spooled to
a Novell server, drag the job to the Hold queue on the Splash G640 and delete it.

Cannot print to Server via AppleTalk

The Splash G640 does not appear in the list of AppleTalk printers on the server. To
workaround this problem, enable Enterprise Networking and configure a TCP/IP printer
using the Splash G640 IP address.

Enterprise Networking

If the Splash G640 is moved to a new subnet on a network, Enterprise Networking may fail
to establish a connection to the network. To remedy this, quit the Splash G640, quit the
Classic environment, and then restart the Splash G640. It may be necessary to repeat this
process two or three times. If this fails to correct the problem, re-install the Splash G640
software.

LPR printing setup

LPR setup may error upon accepting a printer name. Try repeating the procedure or
restarting the computer.

Unstapled jobs

On printers with an attached finisher, all unstapled, uncollated jobs are delivered to the
center output tray. Collated jobs are delivered to the finisher tray regardless of staple setting.

Driver and application Collation options

Most print drivers and some applications support a Collate option. To receive properly
collated or stapled output from the Splash G640 at the highest possible output speed,
disable the Collate feature in the print driver and application and enable the Splash G640

Collate feature.

Heavyweight duplex from Trays 2, 3, 4, and 6

Duplexing of heavyweight paper from Trays 2, 3, 4, and 6 is not supported by the printer.
Attempting to print duplex pages on heavyweight paper from Trays 2, 3, 4, and 6 will cause
paper jams. To print duplexed documents on heavyweight paper, print using manual duplex
from Tray 5.

4-Up LaserWriter 8 print jobs
Jobs sent to the Splash G640 with the LaserWriter 8.x driver that have 4-Up printing

selected show incorrect information in the Pages Printed field in the Job Info window at the
Splash G640. The Job Info window appears when you double-click the job spool file in the
Splash G640 window. The Splash Job Log records the correct number of printed pages for
the job.
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Feed direction with duplex alignment

Some DocuColor 12 printers can be out of alignment beyond what is normally expected
(25-30 pixels). Entering an offset to correct the alignment can worsen the situation. To
remedy this problem, manually adjust the feed direction alignment by entering different
values into the Feed Direction Offset option of the Duplex Alignment dialog box. Print
verification targets to determine when the misalignment is corrected. Although duplex
alignment works for all page sizes, negative offsets in the feed direction on A3 bleed may
have no effect.

Printer timeout settings

The maximum DocuColor 12 timeout settings recommended for use with the

Splash G640 are as follows:

* Job Completion Timeout—1 minute

* Job Program Incomplete Timeout—1 minute

¢ Network Controller Job—15 seconds

* Network Controller Job Complete—15 seconds

Setting these timeouts higher than the recommended maximums can result in jobs which

fail to print completely or jobs which display long delays between printing pages. The
timeouts may be lower than the recommended maximums.

Mailbox Full

When a job is printed to one mailbox bin while another mailbox bin is full, a message
stating that the mailbox is full appears. The job continues to print while the message is on
the screen.

Orientation setting for dropped graphics files

If the orientation of a TIFF or EPS file, either portrait or landscape, does not match the
setting in the Graphic pane of the default job options, clipping of the graphics file may
occur, especially with full page graphics files. If clipping occurs, edit the job options to
change the orientation setting in the Graphic pane.

“Printer Is Warming Up or In Use” message

On some printers, you may occasionally see an error message stating that the “Printer is
warming up or in use” while you are printing the job. The printer will recover shortly and
resume printing the job.

Interrupt button

Using the Interrupt button on the printer when printing collated documents causes the
output to offset when it resumes printing. If this happens in the middle of a set, you must
align the output manually.

Also, if the Interrupt button is pressed on the printer before a job from the Splash G640
starts to pring, the job prints. The Interrupt button only has an effect while the
Splash G640 is printing a job.
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Job log fields

Very long document names and account numbers appear clipped when the job log is
printed. 20 to 25 characters will print depending on the exact characters in the document

name or account number.

Use Custom Page Size to print ISO B4 from Tray 5

The B4 paper size supported by Splash is JIS B4. When printing ISO B4 from Tray 5 using
the Splash B4 paper size, the printer cycles down after every print. To print from Tray 5, use
a custom page size to define ISO B4.

Duplex alignment offsets

The duplex alignment offsets boxes allow three digit positive numbers to be entered, but
only two digit negative numbers. While inconsistent, it is not expected that three digit

negative numbers will ever be required.

Print time in job log for canceled jobs

Even if no pages are printed for a job, the print time in the job log may not be zero. This
happens most often when a job errors because of some condition at the printer, such as an

out-of-paper condition.

Document set blank pages

The blank pages inserted into document sets to make duplexed jobs have an even number
of pages are displayed in the print status in the server UI while printing. They are not
logged as printed pages.

Apparent delay in printing job
When a RIPping job is above all Print Pending jobs in the Active queue, it becomes the

next job to print. This can cause a delay in printing while the RIPping job readies it’s pages
for printing.

Dropped files error

Some PDE PSD, TIFF-IT, PDF-X, and CT-LW files error with a message stating that you
can only print SRA3 from Tray 5. This occurs when the Relaxed Fit server preference is on
and the file is designed to be printed on a page size larger than SRA3. To print the page,
enable the Force Paper Size option on the Page page of Job Edit, select an installed page
size, and enable Scale to Paper Size, and then release the job.

Duplex alignment instructions in English
Regardless of which language preference is selected for the server, the instructions for the
Duplex Alignment Test and Verify pages are in English.

Print Info strip

Depending on page size selected and duplex binding edge selected, the Print Info strip
may print upside down on the second side of duplex jobs. There is no workaround for

this problem.
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Dropped PDF

Landscape PDF may error with a message that indicates the page size does not match the
page size of the PDF if the page size matching the PDF is not installed in the printer. If the
page size is installed in the printer, the job prints on the correct page size.

Progressives

Jobs printed with the Progressives option ignore the Process and Hold option and print.
The image files are saved.

Flip Vertical and Flip Horizontal

In certain cases, when the Flip Horizontal or Flip Vertical check boxes in Page Setup
Options are selected, they either have no effect or their actions reverse (that is, Flip Vertical
causes the object to flip horizontally, and Flip Horizontal causes a vertical flip).

Held job goes to Error queue

If a RIPping job which is mapped from Letter to A4 or vice-versa or from Tabloid to A3 or
vice-versa is held, the job goes to the Error queue with a warning message that the job
printed, but the page size was mapped.

Jobs return to Hold queue

Jobs that are Print Pending or Processing return to the Hold queue when Stop Processing is
selected at the Splash G640. You must transfer them to the Active queue to process and
print when processing is restarted.

TIFF-IT Converter

For some TIFF-IT files, the TIFF-IT generates additional output files beyond the necessary
ones. These files have names like “xxx.fp.4”. They immediately go to the Error queue.
Delete these files.

Calibration target

While printing the calibration targets from ColorCal or CopyCal, a message may appear
warning that a tray is out of paper. The message disappears when the target finishes
printing.

Tray 5

In the tray selection dialog box of ColorCal and CopyCal, you can select Tray 5 only if
there is paper in Tray 5. To enable Tray 5, put paper into Tray 5 before starting calibration.

ColorCal

While printing or scanning, the ColorCal window does not redraw correctly. If another
window is moved in front of ColorCal, the ColorCal window does not update until the
print or scan is complete.

Also with a DC 12 LP, sometimes the software does not recognize that the scanner is
attached. When this occurs, ColorCal displays the message, “Can’t find scanner”. When
this occurs, cancel the scan, quit ColorCal, and then press the Scan button on the scanner.
Wait a few seconds, and then restart ColorCal.
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CopyCal

CopyCal allows an empty string as a profile name. This results in the creation of a profile
with no name. The profile can be used by the Splash G640 and located in the Finder, but is
visually distracting.

ColorTuner substitution

If you select the color menu in the color substitution dialog box of ColorTuner immediately
after printing a proof, the menu may display all colors as either black or red. If this occurs,

wait a few seconds, and then access the menu again.

ColorTuner global sliders

The sliders for global RGB and CMYK color correction stop at the value 99, even though
100 is a legal value. To enter 100, type it in the text edit field.

Previous tuning

If you select to ColorTune a job that has been previously tuned, ColorTuner applies the
previous tuning, regardless of the setting selected in Enable Color Tuner on the Quality
pane of Job Edit. To workaround this problem, before tuning or deleting the changes in the
ColorTuner dialog box, clear ColorTuner from the job.

Hexachrome colors

Type P Hexachrome colors appear twice in the list of colors in the Spot Color Editor, once
in lower case letters, once in all caps. To guarantee that desired changes to a hexachrome

color take effect, edit both versions to the desired new settings.

Selected family

The Spot Color Editor does not remember the last selected spot color family across restarts
of the application. If you quit the Spot Color Editor, and restart it, the spot color family
will always reverts to the default, Type P

Spot Color test page in English

Regardless of which language preference you select for the Splash G640, the Spot Color
Test Page is in English.

Imposition files error

Some imposition files error with the message, “The output does not fit on page size
selected”. This means that the input page size was too big to be imposed on the selected
output page size. To impose the file, do one or more of the following:

* check to make sure Crop Marks or Registration Marks are selected if the application
supports them

* select a larger output paper size

* select the imposition option, Scale To Fit

* select a smaller page size in the Page Setup dialog

In addition, some imposition files error with a message stating that the Splash G640 does

not recognize the application that generated the spool file. When this happens, contact

technical support to get the latest update to the imposition software. If this fails to correct
the problem, technical support may ask for a copy of the spool file for evaluation.
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Imposing landscape jobs errors

Imposing a letter landscape job onto Tabloid errors with the message, “Output Does Not
Fit”. The landscape pages cannot be properly imposed on the Tabloid selected. Shrink the
input pages to a size smaller than letter or use the Scale To Fit imposition option.

Imposing PDF with mixed pages

Imposing a dropped PDF with mixed landscape and portrait pages imposes the document,
but the landscape pages appear clipped. To workaround this problem, print the document
from Acrobat.

All Files option
When using Profile Loader with the All Files option selected, the files in the file list

sometimes remain grayed out. The files are selectable, however.

PSD Converter

The PSD Converter preferences report that the default watched folder is in the
Applications folder. The PSD Drop Folder is actually in the Splash folder. Files placed in
the PSD Drop Folder are processed and printed correctly.

Canceling change of Watched Folder

In the CT-IW converter, canceling the dialog box which selects the new Watched Folder
results in a change to the selected Watch Folder. Always select the desired Watched Folder
in this dialog box.

Drop-Printed files

The user name field on the cover page of drop-printed TIFF and PDF files is incorrect. For
TIFF files, the field is blank. For PDF files, the user name is “PDF File.” This field may also
be blank for drop-printed EPS files depending on file contents.

Jobs from Windows NT 4.0

Jobs printed from a Windows NT 4.0 computer may show the IP address of the computer
as the user name for the Splash spool file instead of the user name from the computer.

Jobs from Windows NT and Windows 2000 via AppleTalk

When printing to the Splash G640 from a Windows NT or Windows 2000 computer via a
port configured with AppleTalk, the user name for all jobs appears as either “Not Known”
or “Unknown”, depending on the application.

Secure Access

Secure Access user names are case sensitive. Creating users John Doe, john doe, and JOHN
DOE is valid. Because the sorting of user names is case sensitive as well, The names may not
appear next to each other in the list of users.

Downloaded fonts

If you attempt to print a document that uses a downloaded font immediately after
downloading the font, the font may print as a bitmap. Wait a few seconds after
downloading before printing a document containing the font.
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Downloading fonts with Adobe Downloader

Downloading fonts using Adobe Downloader may crash the Splash G640. Download fonts
with the Apple Printer Utility instead.

Auto Tray selection

In the Print dialog box for Mac OS applications other than PageMaker, Auto Tray selection
is listed twice. Either selection correctly selects automatic tray selection at the Splash G640.

Client password and Energy Saver

On all clients, the password in the Secure Access dialog box or Doc Info window is
normally not displayed in clear text. On Mac OS clients if the Secure Access dialog or Doc
Info window is onscreen when the Mac OS enters Energy Saver mode, the password

appears as clear text when the system wakes up.

Custom Page sizes (Mac 0S X)

The currently released version of the OS X print driver does not support custom page sizes.
There is no workaround for this problem.

Secure Access (Mac 0S X)

Secure Access does not currently work correctly on the OS X print driver. The driver
prompts for the Secure Access information, but the information is not transferred to the
Splash G640 with the job, so the print job errors. To print the job, you must re-enter the
information at the Splash G640.

Uninstall reports (Mac 0S X)

The uninstall procedure reports an error removing some files when in fact the uninstall
completed successfully.

Unable to delete custom driver (Mac 0S X)

Attempting to delete the Splash Mac OS X custom driver via the Finder fails because of a
permissions error. To delete the custom driver, use the Mac OS X installer program’s
Uninstall option.

Installing from a Windows NT/2000/XP server (Mac 0S X)

On some systems and networks, installing the Splash G640 or OS X client can cause the
system to hang or crash at the end of the install process. This only occurs if the installer
resides on a Windows N'T/2000/XP server. If a hang or crash does occur, reboot the system.
To avoid the hang, copy the installer from the Windows N'T/2000/XP server to the local
hard drive before installing. The problem does not occur with Mac OS servers.

Custom install (Mac 0S 9.x)

The Custom install options for the different languages in Mac OS 9.x do not fully replace
any previous Easy install or Custom install. Some screens still appear in the previous
language. To correct this, open the Extensions folder and delete the AdobePS and Adobe
Printing Library files and the Watermarks folder, and reinstall the desired language.

Custom Page Size (Mac 0S 9.x)

On the Mac OS 9.x Brazilian Portuguese print driver, the Custom Page Size option is
named “Pagina p+”.
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Custom Page Size

On Windows computers, Automatic and Trays 1 through 4 and Tray 6 are enabled when a
custom page size is selected. However when printing custom page sizes, always select Tray 5.
Selecting any other tray usually results in the job erroring with a message stating that
custom page sizes must be printed from Tray 5.

Canceling from Secure Access

On all Windows platforms, when you select Cancel in the Secure Access dialog box, some
applications display an error message. Click OK and continue.

Path names in server window (Windows NT)

When printing from some applications on Windows NT, the job name that appears in the
Splash G640 window is the complete path name on the disk where the job originated,
including the file name. This does not affect printing of the file.

Point and Print jobs (Windows NT)

Some color jobs printed from Windows NT using Point and Print print in grayscale.
Printing from the application itself corrects this problem.

Printer properties warning dialog (Windows 2000)

After installing the Splash custom print driver for Windows 2000, select the printer icon,
and then select the Printer Properties option. A message appears stating that options cannot
be displayed and you are prompted to install the driver. Selecting Yes causes the Add Printer
Wizard to execute again, and a warning message informs you that the driver is not tested by
Microsoft (Choose “No” to display the printer properties). The Splash G640 options are
always available in applications on Windows 2000 and can be accessed by clicking the
Printer icon and choosing Printer Preferences>Advanced.

Printing from the Windows NT or Windows 2000 Custom Driver

For jobs printed from the Windows NT or Windows 2000 Custom Driver, the number of
pages is displayed at the Splash G640 as ?22?. The correct number of pages is displayed for
jobs printed with the PageMaker PPDs from Windows N'T and Windows 2000.

Test page (Windows 98)

The logo on the Microsoft Windows printer test page prints in black and white the first
time it is printed. On subsequent prints of the test page, the logo is in color.

Check marks in Web interface

Check marks on jobs in the Splash Web interface disappear when the automatic refresh
occurs. Reselect the jobs to edit.

Preview images in Web Queue Manager

If an error message appears on the screen, the previews may disappear. To view them again,

click Preview.



Page 11

Turn off Caching in browser

When viewing the Splash G640 via the Web interface, turn off caching in the browser.
Caching occasionally causes out of date information to appear in the Web interface.

TO TURN OFF

Applications

CACHING

Netscape—In the Netscape preferences, choose Category: Advanced: Cache. For “Document in
cache is compared to document on network”, select “Every Time”.

Internet Explorer 4.5 (Mac 0S)—Choose Edit Menu: Preferences: Web Browser: Advanced:
Cache. For “Update Pages”, select “Always”.

Internet Explorer 5.0 (Windows)—From the Tools Menu, choose Internet Options>
General > Temporary Internet Files. Click Settings, and for “Check for newer version of stored pages”,

select “Every visit to the page”.

Some jobs display incorrect name

Jobs with a ‘%’ character in the name display incorrectly in the list of jobs on the Web
interface. No damage to the file is caused by this problem; however, to avoid this problem,
rename the job removing the ‘%” character.

Web interface updates with Internet Explorer 4.0

On some Windows systems, Internet Explorer 4.0 may display out of date information in
the Splash Web interface. If this occurs, make sure the cache setting is set to “Every visit to
the page.” If this does not correct the problem, upgrade to Internet Explorer 5.0.

General

Stapled output printing from Microsoft applications on Windows—When printing
landscape documents from Microsoft Word, PowerPoint, or Excel from Windows 9x,
Windows NT, or Windows 2000, you must select the Microsoft Rotate print option or the
Splash Rotate print option in order to receive output with the staples in the proper
position. The Rotate option is not necessary when printing for other applications from
Windows or from Mac OS.

Print separations in color option—Some applications, including FreeHand, Canvas, and
Corel DRAW provide an option to print separations in their own colors. Selecting this
option causes the Splash G640 to either output the individual separations in color or
improperly composite the separations, depending on the application. For correct output

from the Splash G640, deselect this option.

Microsoft Excel

Number of copies—Sometimes when printing multiple copies from Microsoft Excel on a

Mac OS computer, only one copy prints instead of the requested number of copies. Resend
the document or change the job handling option to something other than Print and Delete
so you can set the number of copies at the Splash G640 if the correct number fails to print.

Page size scaling—The page size scaling set in Excel overrides the page size scaling set in
the print driver. Use Excel to set the desired scaling.
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QuarkXPress

Scaling pages—To scale pages when printing from QuarkXPress, use the Scaling option in
the Quark print options window. The Scaling option in the print driver has no effect.

Secure Access—When printing from QuarkXpress on a Mac OS computer, you must click
the Printer button in the QuarkXPress print dialog box in order to be prompted for Secure
Access information. Then when you select “Print” to return to the Quark print dialog box,
you are prompted for Secure Access information. If you do not click the Printer button, the
job spools to the Splash G640 with the information was last entered for Secure Access or in
the Document Info window.

Adobe Acrobat

Stapled Output—When printing landscape documents from Acrobat or Acrobat Reader
from Windows 9x/Me or Windows N'T/2000/XP, you must select the Splash “Rotate” print
option in order to receive output with the staples in the proper position.

Adobe FrameMaker

Printing collated documents—When printing multiple copies of a document from
FrameMaker, the application always outputs multiple copies of each page in the print job
sent to the Splash G640. This means that features, such as stapling and offsetting, do not
work correctly. To print a properly stapled or offset job from FrameMaker, select one

copy in the print driver, and then edit the job at the Splash G640 to set the desired number

of copies.

Adobe Freehand

Windows NT and 2000— When printing from FreeHand versions 8 and 9 on Windows NT
and Windows 2000, Splash job options cannot be modified. To set job options for
FreeHand, modify the printer’s defaults in the Printer Properties dialog box and then print
from FreeHand.

Application field on Info pane—For some jobs printed from FreeHand 8 and Photoshop
5.5, the Application Field on the Info pane contains the document name rather than the
application name.

Adobe Illustrator

Illustrator 9 dropped PDFs —Landscape files saved as PDF in Illustrator 9 appear clipped
when printed at the Splash G640 or viewed in Acrobat. To print the file correctly, open it in
Mlustrator and print to the Splash G640.

Fonts—Illustrator downloads many fonts even if they are already installed at the
Splash G640. The fonts print correctly and do not bitmap.

Adobe InDesign

Printing separations—When printing separations from Adobe InDesign, selecting the
In-RIP separations option causes the plates to print as individual grayscale pages. To
properly composite separations, do not select this option.
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Adobe PageMaker

Windows—On Windows 9%, Windows NT, and Windows 2000, you must copy the
Splash G640 PPD to the PPD4 folder inside the PageMaker folder. For instructions, see
PageMaker documentation.

Mac 0S—When printing from PageMaker, if you have removed PPDs from your system
after previously using them in PageMaker, the warning message “XXX PPD cannot be
found. Using default.” appears, where XXX is the name of the printer model. Click OK and
continue printing.

Also, the Reset button in the PageMaker print dialog box does not reset the Splash job
options to their defaults. You must set the Splash options individually to default values.

Atlas PrintShop Mail

Variable data jobs—jobs printed using the Forms option from PrintShop Mail version
3.1.5 on a Mac OS and PrintShop Mail version 2.2 or prior on Windows 98 error with a
PostScript error. The jobs may print some pages before erroring. To print variable data jobs
properly from these applications, use the Splash VI option.

PrintShop Mail version 971—if you are running PrintShop Mail version 97 on Windows 9x,
the Splash VI option does not appear. When you print a variable data job to Splash, the
application reports an “invalid restore” PostScript error. If this happens, use the following
procedure to adjust the settings in the Windows Printers control panel.

TO ADJIUST THE PRINTERS CONTROL PANEL SETTINGS

1.

2.

Double-click the My Computer icon on the desktop.

Double-click the Printers folder.

Select the printer icon for your Splash printer.

Choose Properties from the File menu.

Click the Postscript tab.

In the Postscript output format list, select Postscript (optimize for portability — ADSC).
Click the Fonts tab and then click the Send Fonts as button.

In the Send True Type fonts as list, select Type 4.

Click OK in all open Printer properties windows to save your changes.

You can now print to the Splash G640 from PrintShop Mail.

Transparent data and Splash VI—When using transparent data, use the Optimized
PostScript option rather than Splash VI. While this is usually slower than Splash VI,
transparent data does not print properly with Splash VI enabled.
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CorelDRAW

Using the custom driver on Windows NT/2000—When printing with CorelDRAW 8 on
Windows N'T/2000, using the Splash custom print driver cause CorelDRAW to crash. To

use the Splash custom print driver, use the noncustom PPD with CorelDRAW 8 or
upgrade to Corel DRAW 9.

Number of copies—When printing from Corel DRAW) set the number of copies in the
application’s print window. The number of copies in the print driver window are not sent to

the Splash G640.

Corel PrintOffice

Number of copies—When printing from Corel PrintOffice, set the number of copies in the
application’s print window. The number of copies in the print driver window are not sent to

the Splash G640.

Deneba Canvas

Imposition files—Files printed from Canvas with the Saddle Stitch, Perfect Bound, or Step
and Repeat options selected error at the Splash G640. There is currently no workaround for
this problem.

Foreground printing—If you select the printer driver’s Foreground Printing option, printing
from Canvas on Mac OS 9 fails. The job returns to the Hold queue without printing. Use
the Background Printing option instead.
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